JSN UniForm Configuration Manual
Introduction
JSN UniForm is a Joomla! Form extension which helps you create forms quickly and easily - from normal to complex.
Moreover, you can efficiently manage all the submissions as the administrator. The configured form can be published in any
part of the website including: in article content, in the main body area and different module positions.

Compatible with Joomla! 3x
Recently, the Joomla! Official team has released Joomla version 3.8.8, and most Joomla! Users have now updated to the latest
version. JSN UniForm is compatible with all the versions of Joomla! 3.x, so there is nothing for panic.

Requirements to use JSN Uniform

System Requirements

Joomla

Joomla 3.x+

PHP

PHP 5.6 +

Database

MySQL 5.1 +

Apache 2.0 +
Web Server

Microsoft IIS 7 +
Nginx 1.0

Firefox 4+
Chrome 10+
Browser Requirements

Types

Opera 10+
Safari 5+
Microsoft Edge

WampServer
Windows

Development Environment

Linux

XAMPP

XAMPP

MAMP
Mac OS

XAMPP

Now, it is time to install JSN UniForm on your Joomla! Site.

Getting Started
Welcome to JSN UniForm. In this section, you will get involved in installation step before you go forward!

Installation
Following two steps to install the package.

Step 1: Getting The File
Download the latest stable version of JSN UniForm from this location:https://www.joomlashine.com/joomla-extensions/jsnuniform.html (https://www.joomlashine.com/joomla-extensions/jsn-uniform.html)

Step 2: Installation
In Joomla! Administration, go to menu Extensions → Manage → Install.

Start installing JSN UniForm extension

In the Extensions: Install page click on the Upload Package File tab. At here, there are 2 ways you can choose either to install
the installation package:
Click on Or browser for the file button.
Drag and drop the package to the box.

Start installing JSN UniForm extension

Upload & Install JSN UniForm

Installation of JSN UniForm was successful

Features in Detail
This section introduces the features JSN UniForm.

JSN UniForm features detail

1. Toolbar (https://www.joomlashine.com/documentation/jsn-extensions/jsn-uniform/jsn-uniform-configurationmanual.html#features-in-detail_toolbar)
2. Form Creation (https://www.joomlashine.com/documentation/jsn-extensions/jsn-uniform/jsn-uniform-configurationmanual.html#features-in-detail_form-creation)
3. Submissions Control (https://www.joomlashine.com/documentation/jsn-extensions/jsn-uniform/jsn-uniformconfiguration-manual.html#features-in-detail_submission-control)
4. Integrations (https://www.joomlashine.com/documentation/jsn-extensions/jsn-uniform/jsn-uniform-configuration-

manual.html#features-in-detail_integrations)
5. Configuration (https://www.joomlashine.com/documentation/jsn-extensions/jsn-uniform/jsn-uniform-configurationmanual.html#configuration)
Let’s explore each feature!

Toolbar
The toolbar contains many quick features base on the toolbar’s structure of Joomla! Default.

JSN UniForm toolbar

Below is a list of features you can play with the Toolbar area.

Features

Description

This feature to help you quickly create your form.
Click on the New button, here you can see the seven sample forms like screenshot below.

New

Create a new form

On the demo of JSN UniForm, you can check out more sample forms.
(https://demo.joomlashine.com/joomla-extensions/jsn-uniform/sample-forms.html?
_ga=2.77966676.1124931101.1530061930-1584483775.1493177639)

It allows you to edit the form(s).
Edit

Duplicate

Make a selection from the list of the forms and click on Edit button.

It allows you to duplicate the form(s).
Make selection(s) from the list of the forms and click on the Duplicate button.

Export

This feature allows you to export the form(s) to .json file.
Make selection(s) from the list of the forms and click on Export button.

This feature allows you to import the form(s) to JSN UniForm.
Click on Import button and choose your .json file to import like the screenshot below.

Import

JSN UniForm import

Publish

It allows you to publish the forms is unpublished.
Make selection(s) from the list of the forms and click on Publish button.

Unpublish

It allows you to unpublish the forms is published.
Make selection(s) from the list of the forms and click on Unpublish button.

Delete

It allows you to delete the form(s).
Make selection(s) from the list of the forms and click on Delete button.

This menu includes submenus are all the main features of JSN UniForm.

Menu
Menu on the toolbar

Help

Click on Help button you should be redirected to the help page. Here you can go to Documentation
and Support Forum page of JoomlaShine via the links.

Form Creation

Form creation

This section included contents of:
1. General Tab: In this tab, you can add form details and general options.
2. Form Design: Here you can create the form content you require.
3. Scripts Tab: The JSN UniForm! Script sections offer an increased flexibility.
4. Metadata: Here you can add some meta tags are Meta Description, Meta Keywords and set Use form title as page title if
you want.
5. Form Action: In this section, you can set up Email Notification, Post Submission Action and MailChimp Setting.

General Setting

JSN UniForm general settings

Here you can set general information for your form:

Title
Description
Status
Ajax Upload
Allow Front-end Submission Editing
Allow Front-end Submission Viewing
Captcha Integration
Payment Integration

Below is the list of feature you can to do with the General Tab.

Features

Description

Title

Type the title of your form.

Description

Type the description for your form.

Status

Select Published or Unpublished for your form.

This feature helps you show the progress bar when user uploads a file in the form.
Select Yes to show the progress bar on your form like screenshot below.

Ajax Upload

Progressing bar shows on the form

Select Yes and select permission level required to be able to Edit submission’s details at the
frontend like the screenshot.

Allow Front-end
Submission Editing

Enable “Allow Front-end Submission Editing” feature

Allow Front-end
Submission Viewing

Select Yes and select permission level required to be able to View submission’s details at the
frontend like the screenshot in the Allow Front-end Submission Editing row above.

Captcha Integration
To protect your website from spam, the Captcha function should be used. The system will require submitters to fill in the
reCAPTCHA or Securimage to protect forms from spam and abuse.
To add a Captcha field, in General tab → Options area → Captcha Integration option → choose a type that you desire,
ReCaptcha or Securimage.

Captcha Integration

ReCaptcha

ReCaptcha

Select ReCaptcha type from Captcha Integration option, you should see a notification as shown below:

ReCaptcha setting notification

To enable the Captcha - ReCaptcha plugin, you can click on the word "here" as shown on the screenshot above or go to
Extensions → Plugins → search Captcha - ReCaptcha plugin.

Captcha - ReCaptcha plug-in

Here you can select the version for ReCaptcha. Version 2.0 is recommended because version 1.0 is disabled.

Securimage
Currently, some areas in the world are about to stop using reCAPTCHA on websites for the sake of the GDPR, so Securimage is
another way to Captcha and still makes your Joomla form compliant with the GDPR.

Securimage

To enable Securimage captcha show on your form, in the General tab → Captcha Integration option → select Securimage
type like the screenshot.

Enable Securimage

Payment Integration
This feature allows you to create a form with Paypal integration is quite simple and fast.
Payment Integration should be set to Paypal (or other payment methods).

Enable Payment Integration

Define form fields with Payment money value active. In tab Design, you can add/edit form fields normally, except for
some fields those have an extra option Payment money value active. For example like the screenshot.

Enable payment feature on the fields

Form Design

Design tab

Here you can create the form content you require. You should be setting for:
Form Type
Form Layout
Form Style
Form Field
Let’s explore each area!

Form Type
There are two options for you to choose from: Single page and Multiple pages.

Form types

Below is the list of form types you can to do with the Form Type.
Form Types

Description

Your form will be presented in only one page.

Single page

Single page

You form will be presented on multiple pages. This option is useful when your form is long.

Multiple pages

Multiple pages

Form Layout
This feature allows you to choose a Vertical layout or Horizontal layout for your form.

Form layouts

Below is the list of form layout you can to do with the Form Layout.
Form Layouts

Description

This option allows you to show the title and field vertical.

Vertical layout

Vertical layout

This option allows you to show the title and field horizontal.

Horizontal layout

Horizontal layout

Form Style
This feature allows you to style for your form by options:
Color Scheme
Container
Title
Field
Error
Buttons
CSS
To do this, go to the Form Style page.

Form styles

Below is the list of tabs you can to do with the Form Style.

Options

Description

By default, this option includes two color schemes for your form: Light and Dark.

Color Scheme

Color Scheme

You can add more new Color Schemes to the list by click on green Plus button.

This tab included the options that help you change attributes for form such as background, border,
padding, etc.

Container

Container tab

Background Color: Adjust the form’s background color.
Background Active Color: Adjust the activated background color.
Border Thickness: Insert value here to edit the thickness of the border.
Border Color: Adjust the color of the border.
Border Active Color: Adjust the activated border color.
Rounded Corner Radius: Insert the radius value of the rounded corner.
Padding Space: Insert the padding value into this option.
Vertical Space: Insert the distance between fields here.

The Title tab included the options help you change the font style for the form, with the attributes
as text color, font type, font size.

Title

Title tab

Text Color: Choose the text color of your form.
Font Type: Select the font type of the text.
Font Size: Adjust the font size.

This tab allows you to customize fields with the attributes background color, border color, shadow
color, text color.

Field

Field tab

Background Color: Adjust the background color of your form’s fields.
Border Color: Adjust the border color of your form’s fields.
Shadow Color: Adjust the shadow color of your form’s fields.
Text color: Adjust the text color of your form’s fields.

The Error Message tab allows you to change the style for error messages, with the attributes
background color and text color.

Error Message

Error message tab

Background Color: Adjust the background color for error messages.
Text Color: Adjust the text color for error messages.

The Buttons tab allows you to change the color and position of the Submit, Preview, Reset, Prev
and Next buttons in your form.

Buttons

Error message tab

Button position: Adjust the position of the button: Center, Left or Right.
Submit: Adjust the color of the Submit button.
Prev: Adjust the color of the Prev button.
Next: Adjust the color of the Next button.

The CSS tab allows you to define your custom style for the form by adding CSS codes in its input
area.

CSS

CSS tab

Form Fields
In this part, you will learn about how to add the field, duplicate field, set up and configure fields to create your form as you
want.

JSN UniForm Fields
Add Field feature allows you to select and add all the fields on the list of fields.

Form fields

After adding fields to your form, click on the Edit icon to start for general setting and insert the values on the Properties section
like the screenshot.

Field’s properties

Below is the list of the field types you can add to your form:

Form Fields

Description

Single Line Text field allows the submitters to insert one single line answer.
Single Line Text

Click on the Edit icon to start for general setting and insert the values on the Properties
section.

Multiple Choice

Multiple choice field for the submitters to choose. You can also adjust the layout and answers of
this field.

Dropdown

Add a Drop-down field for the submitters to select the correct answer.

Paragraph Text

This field allows the submitters to answer the question by a paragraph.

Checkboxes

Add a checkboxes field for the submitters to select. You can also adjust the layout and edit the
checkboxes content.

List

This field allows submitters to select one or multiple answers.

Static Content

Add a static content field to provide information.

Recipient Email

Add the recipient email field to your form to choose the email that the submissions will be sent to.

Identification Code

Add this field to show the identification code of the form.

Add Google Maps fields to your form by using this field.
Google Maps

To use the Google Maps element, you must register your app project on the Google Cloud Platform
Console and get a Google API key which you can add to your app. Get API key here.
(https://developers.google.com/maps/documentation/javascript/get-api-key)

Name

This field allows the submitters to insert their name.

Email

This field allows the submitters to insert their email.

File Upload

This field allows the submitters to upload a file onto the form.

Likert

Add a Likert table that allows submitters to rank the options.

Address

This field allows the submitters to insert their address. Each subfield on this field is made required.

Website

This field allows the submitters to insert their website.

Date/Time

This field allows the submitters to insert the date.

Country

This field allows the submitters to insert their country. You can add more countries to the list.

Number

This field allows the submitters to insert number value.

Phone

This field allows the submitters to insert their phone number.

Currency

This field allows the submitters to insert the currency they want.

Password

Add this field to protect the form, submitters need to insert the password to submit their results.

Conditional Form Fields
To simplify the form filling process, JSN UniForm provides you conditional form fields.
For instance, there is a multiple choice field “Have you used Joomlashine products?” with two answers: Yes and No.
If the submitter chooses “Yes”, the next field “Which Joomlashine products do you like most?” should be shown.
If the submitter chooses “No”, the next field “Which Joomlashine products do you like most?” should be hidden.
To set up this, go to the field “Have you used Joomlashine products?”, click the Edit icon, choose tab Value, click the Lightning
icon of the option No.

Click on the Lightning icon

In the Action settings window, choose tab Hide form field(s) and choose field “Which Joomlashine products do you like
most?”

Choose the form fields you want to hide

NOTE:
You can hide as many form fields as you want.
You can show related form fields which were hidden before. The way to do it is the same as above.
In the list of fields, you can select three conditional form fields are: Multiple Choice, Dropdown and Checkboxes.

Duplicated Field
Duplicated Field element allows you to instantly make a copy of any field.
Hover the mouse to the top right of the field and then click the Duplicate element icon.

Duplicate element

Search Field
If you want to add a specific field, you can input the field type into the Search box; the matching field will appear immediately
so that you can select it and add it to your form. You can search for All Fields, Standard Field or Extra Field.

Search fields

Add Container
To create an area which covers several small fields, you click Add Container. Each container can contain a maximum of 3
fields.

Add container

You can move the selected container up or down very easily. In addition, within each container, you can add columns,
delete columns or drag and drop columns to change their position.

Container’s tool

Add column: allows you to add one column within a container.
Delete column: allows you to delete a column from a container.
Move container up: click on the icon to move the container up.
Move container down: click the icon to move the container down.

Scripts Tab

Scripts tab

Script sections offer an increased flexibility. With the proper PHP / MySQL / Javascript knowledge, you can do just about
anything form related. The PHP Scripts area has three different PHP sections, that are triggered by certain events.
In this section you can custom scripts PHP on:

On Form Display
On Form Process
After Form has been Processed

On Form Display
The scripts added in this area are executed just before the form is displayed.
The main focus in this area is the $html variable.
Example: Restrict access to the form, if the user is not registered:
$user = JFactory::getUser();
$userID = $user->get('id');
if ($userID == '0')
{
$html .= 'Sorry, you must be registered';
}

Note:
You should only add more markups but please do not change this variable, because it contains the HTML code of the
form.
When adding PHP script, remember to not include the tags.

On Form Process
The scripts called by the form creating process area are executed after the form has been submitted (regardless if it's valid or
not). This area is useful when you need to process calculations.
Any modifications to $POST variables performed here will be reflected in the submission entry.
The $post variable contains $POST data of the form.
You can modify it by adding a PHP script below before it is added to the database.

$post['3'] = $post['5'] + $post['6'];

Note:
In the above example we use our own form field ID. You will need to inspect the code of your form to identify your own
form field ID.
Remember to not include the tags.

After Form has been Processed
The scripts called after form process is triggered after emails have been sent and the data has been saved into the database.
This is rather useful when you are trying to record the data sure direct the form depending on some variables (such as
submitted input fields).
The $post variable contains $POST data of the form. You can modify it by adding a PHP script below, after form been
processed successfully.
Example: The total value will be recorded in a file test.txt if the total field is equal to 30.

if ($post['3'] == 30)
{
file_put_contents(JPATH_ROOT . "/tmp/test.txt",$post['3']);
}

Note:
You will need to use your own form field ID.
Remember to not include the tags.

Metadata Tab

Metadata Tab

Here you can add some meta tags are Meta Description, Meta Keywords and set Use form title as page title if you want.
Below is a list of features you can play on the Metadata Tab.

Features

Description

This feature allows you to add the description.
For example, your Meta Description is “This is my custom Meta Description” which will look
Meta Description

like this:

<meta name="description" content="This is my custom Meta Description" />

You can add your keywords here, separate them by commas (For example: Joomla!, contact,
form).
For example your Meta Keywords is “learn JSN UniForm, JSN UniForm tutorial” which will

Meta Keywords

look like this:

<meta name="keywords" content="learn JSN UniForm, JSN UniForm tutorial" />

Use form title as page
title

Form Action

Set Yes if you want to use form title as the page title.

Form action page

In this section, you can set up:
Email Notification
Post Submission Action
MailChimp Setting
Below is a list of features you can play on the Action Tab.

Action

Types

Description

This feature allows you to:
Add email addresses to receive email notifications whenever a form is
submitted to your website.
Add multiple recipients for the admin notification emails.
Customize the content of the e-mail by selecting the relevant values.

Email Notification

Send to
email(s)

Send to email(s) feature

An email will be sent to submitters to inform them about successful submission.
Within these emails, you can attach files which submitters uploaded in form.
In the tab Design, you add the field(s) File Upload like the screenshot.

Add “File Upload” field

Then in the tab Action → section Attach File, you will see the option to choose
File Upload.

Send to
submitter

Send to submitter

This feature supports your site to become more friendly with the GDPR. With this
feature you can:
Decide to save any form submission or not.
Set up the action you want submitters to see after submitting their form.

Post Submission
Action

Post Submission Action

This feature allows you setting for use MailChimp or not.
Select Yes or No to turn on or turn of MailChimp.

MailChimp Setting

MailChimp Setting

Submission Control
Submission Control section allows you to manage your data is easier than ever.

Submissions tab

Below is a list of features you can play with the Submission Control.

Features

Description

In the submissions toolbar, you can export the submissions to Excel, CSV, PDF. Also, you
can Delete submissions.

Export

Submissions toolbar

It allows you to delete the submissions.
Select submission(s) and click on Delete button.

Delete

Delete submissions

You can filter items with submission information such as Name, Email, etc.

Filter submission by
Submitters Name/Email

Filter submission by Submitters Name/Email

You can filter items with submission information such as submit date.

Filter submission by Date

Filter submission by Date

Allows you to select the information of other forms on the list of the form.

Select the information of
other form

Select the information of other forms

This function allows you to filter the status of orders for sales management.
It applies to all submissions made via payment methods which JSN UniForm
supporting: Paypal, Authorize.Net, Stripe, 2Checkout.
Make sure that you selected a payment method on the General tab of each form.

Payment Status

Selected a payment method

Go to Submission Manager, you will see 02 statuses: Success and Failure to filter.

Select status to sort orders

You can choose to display important fields in this general submissions page.

Organize submission fields

Organize submission fields

You can control the number of line per page with this feature by choosing one of the

options in the list.

Number of lines viewed

Number of lines viewed

You can click on each submission to check its details. Also, you can edit and print any
submission by clicking Edit and Print button.

Check submission details

Check submission details

Integrations
This feature to support payment, JSN UniForm provides some plugin to support payment such as Paypal, Stripe, Authorize.Net,
and 2CheckOut. You can also integrate Mailchimp.

Integrations tab

How to install payment Plugins
Step 1: Click on the "Install" button

Click on the "Install" button

Step 2: Verify Payment Plugin
If you already purchased the payment plugin, just click on blue I already Purchased the plugin_name, please install button.
For example with Stripe payment plugin like the screenshot below.

Verify Payment Plugin

Also, you can Uninstall, turn on/off and Update payment plugin by click on each icon on the table of the list plugin like the first
screenshot in this section.
To have more details about how to setting for each payment plugin, let check to each section below.

Mailchimp Integration
JSN UniForm is integrated with MailChimp using MailChimp API. It allows you to subscribe users to each or your individual
MailChimp lists.

How to get MailChimp API
Log in to your MailChimp (http://mailchimp.com) account and get access to your account information, you will find your API
key under the tab “Extra”

If you have not had your API yet, click “Create A Key” and your API will be automatically generated.

Configuration
Under the action tab, you can find MailChimp settings under “Post Submission Action”
Click yes to Use MailChimp
Insert your MailChimp API Key, then click OK

Your MailChimp lists will appear under “Mailchimp List” section

List submission settings
Click on your MailChimp list name, you will see options to match your UniForm with MailChimp Field. You can also add and
remove a field easily here.

Add or remove a field

UniFrom Field

MailChimp Field

Then you will be able to choose the list to subscribe users to

You can also choose to custom your MailChimp Field to add new field to your MailChimp list directly from JSN UniForm
screen.

Click save and your form will be ready

Paypal Integration
From ver
rsion 3.1.6, JSN Uniform is updated with a new feature to support Paypal payment. Now with the Submit button, you can direct
users to Paypal payment gateway integrated with JSN Uniform where they can make the purchase for the items chosen in the
form with their own Paypal accounts.

Uniform with Payment money value active

Uniform with Payment money value active
In this section, you can perform a variety of configuration and maintenance tasks such as data backup/restore, sample data
installation, theme management, etc.

Configuration
JSN Uniform payment gateway must be configured correctly to be usable. Firstly, you should update some information in
Paypal plugin for Uniform. You can access this plugin through Uniform Global Parameters.

If the plugin is installed then click on the Setting button to enter configuration section.

Paypal API
In the Paypal API, you can see the option of switching Test mode on and off, with Test mode on, Uniform will use Paypal
Sandbox API to simulate every payment, which is suitable for testing Paypal with your website.
Payment type you can select the type for payment, it has Standard Checkout and Express Checkout.

Standard checkout

Express checkout

Extra Options
With Cancel URL, you are able to set the location where users will be directed when they click on Cancel and Return link.

Logo parameter lets you define the URL to the logo image displayed on the Gateway page.

Archive Cancel Transaction: Set Yes if you want to archive all transaction canceled.
Receive Confirmation Of Successful Transaction Set Yes an email will be sent to admin and submitter when the transaction is
done.
Currency: you can select a currency type for payment gateway.
Currency Symbol Position: Set currency symbol position for presentation.
Paypal Live & Sandbox API Credentials

In these sections, you need to provide your Paypal credentials into all 3 fields API Username, API Password, and API Signature.

Sandbox API Credentials

Live API Credentials
In order to get a Sandbox Test Account, you should access developer.paypal.com/developer
(https://developer.paypal.com/developer) with your own Paypal account and visit Dashboard page.

Under Sandbox section please click the link Accounts, you can see a list of auto-generated emails associated with your Paypal
developer account:

If you want a new account, simply click Create Account and provide essential information for your new test
account. Notice that if you need an account with API credentials, you have to set its Account Type to Business
(merchant account)

Otherwise, to see Sandbox API for accounts in the list, click on Profile under account name (Business Type). A
popup window will appear with several tabs, API information is fully shown in the tab API credentials
.

Apart from Sandbox API, you can bring your Paypal application into production by requesting Live API credentials.
To receive your Live API credentials, please follow these steps:
Go to your Paypal account at www.paypal.com (https://www.paypal.com/)

Access your Profile and enter My selling tools section

In this section, you can see the field API access section, choose Update to proceed to the next page.
In API access page, click View API Signature in Option 2

In the Request API credentials page, please choose Request API signature and click button Agree and Submit

In the next page, API information can be revealed by clicking Show buttons:

Currency Options

Currently, Paypal has support for 22 Currencies, you can freely choose one of them to assign for the Uniform with position
option among Left, Right, Left with space, Right with space.

Set up form with Payment Integration
Creating a form with Paypal integration is quite simple and fast in JSN Uniform.

Enable Payment Integration

First of all, in tab General, Payment Integration should be set to Paypal.

Define form fields with Payment money value active
In tab Design, you can add/edit form fields normally, except for some fields those have an extra option Payment money value
active. Setting this option to Yes will include the field item and its monetary value to Paypal submission.

For example with the Multi-Choice field Processor in the picture, Payment money value is active. In each item line there are
additional parameters [PRICE:{value1}] and [QUANTITY:{value2}] which defines the money value and quantity for the related
item in the list. You can open a dialog to define these parameters for each item by clicking on the button $ appearing when you
hover over that item's name:

Value item list

Money and quantity parameters

These parameters will not be shown in frontend but Uniform will use their values to calculate the payment displayed in Paypal
gateway.

With Total money field, you have the option to show Total money value calculated from chosen items in a form.

Total money field in Backend

Total money field in Frontend

2CheckOut Integration
Step 1: You can click the "Components" -> JSN UniForm -> choose integrations
Step 2: JSN UniForm: Integration screen -> Click the "setting" button in 2CheckOut field

How to set 2CheckOut payment
General setting

Test Mode: Set 'yes' if you want to be in 'Test Mode'
2CheckOut Parameters & 2CheckOut Sandbox Parameters Setting

In these sections, you need to provide your 2CheckOut credentials into all 2 fields: Vendor ID and Secret

2 CheckOut Parameters

2CheckOut Sandbox Parameters

How to get Vendor ID and Secret
If you want a new account, simply click Sign Up (https://sandbox.2checkout.com/sandbox) and provide essential information
for your new test account.

In order to get a Sandbox Test Account, you should
access https://sandbox.2checkout.com/sandbox/acct/detail_company_info
(https://sandbox.2checkout.com/sandbox/acct/detail_company_info) with your own 2CheckOut account and Site
Management.

Under Sandbox section please click the Accounts, you can see vendor ID

You can see Secret Word in Site Management of account

From here, you will want to copy each key individually and paste them into their appropriate box under 2CheckOut Parameters

3. Currency Options Setting

Currency: Set currency for payment gateway
Currency Symbol Position: Set Currency Symbol Position for presentation
Currently, 2CheckOut has supports for 17 Currencies, you can freely choose one of them to assign for the Uniform with
position options:Left, Right, Left with space, Right with space.

Setup form with Payment Integration
Step 1: Creating a form with 2CheckOut integration is quite simple and fast in JSN Uniform.
Step 2: First of all, in tab General, Payment Integration should be set to 2CheckOut.

Step 3: Define form fields for Payment and then activate its value by choosing Yes

Stripe Integration
Step 1: You can click the "Components" -> JSN UniForm -> choose integrations
Step 2: JSN UniForm: Integration screen -> Click the "setting" button in Stripe field

How to setup Stripe payment
1. General Setting

Test Mode: Set 'yes' if you want to be in 'Test Mode'
Logo URL(Size:128*128px): A relative or absolute URL pointing to a square image of your brand or product. The recommended
minimum size is 128*128px. The supported image types are: .gif, .jpeg, and .png

Name: The name of your company or website
Description: A description of the product or service being purchased
Archive Cancel Transactions: Set 'Yes' if you want to archive canceled transactions.
2. Stripe Live Parameters & Stripe Test Parameters Setting

In these sections, you need to provide your Stripe credentials into all 2 fields: Secret Key and Publishable Key.

Stripe Live Parameters

Stripe Test Parameters

How to get Secret Key and Publishable Key
Once you have selected Test, to get your API type, open up a new window or tab, and visit Stripe.com (https://stripe.com) to get
your API keys. Once you are on the Stripe webpage, sign in, and go to your dashboard.

When you are in your Stripe dashboard, verify that you are in test mode (for the purpose of integration). Then select your
Account and Account Settings. After you have done so, you should see something very similar to the image below.

Select API Keys in the top navigation bar, to retrieve your API keys. After you have selected API Keys you should see four API
keys.

From here, you will want to copy each key individually and paste them into their appropriate box under Stripe Parameters.
For example Stripe Test Parameters should go in the Stripe Test Parameters tab: Input Secret Key and corresponding
Publishable Key .

Once you have added the correct fields, select View Instructions to Enable Webhooks in your Stripe account.

3. Currency Options Setting

Currency: Set currency for payment gateway
Currency Symbol Position: Set Currency Symbol Position for presentation
Currently Stripe supports 18 Currencies, you can freely choose one of them to assign for JSN Uniform with position
options: Left, Right, Left with space, Right with space.

Setup form with Payment Integration
Step 1: Creating a form with Stripe integration is quite simple and fast in JSN Uniform.
Step 2: First of all, in tab General, Payment Integration should be set to Stripe.

Step 3: Define form fields for Payment and then activate its value by choosing Yes

Authorize.Net Integration
Step 1: You can click the "Components" -> JSN UniForm -> choose integrations
Step 2: JSN UniForm: Integration screen -> Click the "setting" button in Autorize.Net field

How to setup Autorize.Net payment
1. General Setting

Logo URL (Size:570*250px): The URL of the merchant's logo
Cancel URL: The URL to which the gateway redirects the customer's browser when the customer clicks the cancel link
Receipt Link Text: The text of the link or button that directs the customer back to the merchant's website (50-characters
maximum)
Transaction Types:
Authorization and Capture: The most common type of credit card transaction. The amount is sent for authorization, and
if approved, is automatically submitted for settlement.
Authorization only: The transaction will not be sent for settlement until the credit card transaction type prior Authorization
and capture is submitted, or the transaction is submitted for capture manually in the merchant interface.
Archive Cancel Transactions: Set 'Yes' if you want to archive canceled transactions
Send IP to Authorize.net: Set 'Yes' if you want to send customer's to Authorize.Net
Test Mode: Set 'Yes' if you want to be in "Test Mode"
2. Authorize.Net Parameters & Authorize.Net Sandbox Parameters Setting

In these sections, you need to provide your Authorize.Net credentials into all 4 fields: Authorize.Net hostname, Login ID,
Transaction Key and MD5-Hash

How to get Login ID, Transaction Key and MD5-Hash
To obtain the API Login ID and Transaction Key:
Log into your Merchant Interface at https://account.authorize.net. (https://account.authorize.net)
Click Account from the main toolbar.
Click Settings in the left side menu.
Click API Login ID and Transaction Key in the Security Settings section.
Under Create New Transaction Key, enter your Secret Answer.
Note: When obtaining a new Transaction Key, you may choose to disable the old Transaction Key by clicking the box titled
"Disable Old Transaction Key(s)". You may want to do this if you suspect your previous Transaction Key is being used
fraudulently.

Click Submit button
If the Disable Old Transaction Key(s) box is not checked, the old Transaction Key will automatically expire in 24 hours. When
the box is checked, the Transaction Key expires immediately.
Be sure to store the Transaction Key in a very safe place. Do not share it with anyone, as it is used to protect your transactions.

Note: The API Login ID. To retrieve the API Key, enter your answer to the secret question and click Submit.

Assuming you answered the question correctly, the transaction key will now be displayed on the screen.

To obtain the MD5-Hash:
Log into your Merchant Interface at https://account.authorize.net. (https://account.authorize.net)
Click Account from the main toolbar.
Click Settings in the left side menu.
Click MD5-Hash in the Security Settings section.
Under New Hash Value and Confirm Hash Value, enter value
Click Submit button

From here, you will want to copy each key individually and paste them into their appropriate box under Authorize.Net
Parameters.

3. Currency Options Setting

Currency: Set currency for payment gateway
Currency Symbol Position: Set Currency Symbol Position for presentation
Currently, Autorize.Net supports for 6 Currencies, you can freely choose one of them to assign for the JSN Uniform with
position options: Left, Right, Left with space, Right with space.

Setup form with Payment Integration
Step 1: Creating a form with Authorize.Net integration is quite simple and fast in JSN Uniform.
Step 2: First of all, in tab General, Payment Integration should be set to Authorize.Net.

Step 3: Define form fields for Payment and then activate its value by choosing Yes

Configuration

In this section you can perform a variety of configuration and maintenance tasks such as data backup/restore, sample data
installation, theme management, etc.

Global Parameters

In General section you can configure:
Load Bootstrap CSS.
Archive IP.
Archive Browser Information.
Archive Operating System.
Upload folder: to define where all uploaded file will be stored.
In Default form section you can configure:
Show empty value(s) in email content.
Sent to email(s): to define what email will be sent in response to each submission.
In PDF Export settings section you can setting for PDF export file

Messages

On some JSN UniForm pages, you might see a hint message guiding you how to use the product. These messages can be
turned on or off.
Just check/uncheck boxes in column Show and click button Save to confirm.

Languages

Currently JSN UniForm supports 17 primary languages. If you haven’t seen your language supported, please drop us a line in
“General inquires” section (/joomlashine/contact-us.html) to join our Translation Team.
Languages management

You can edit the language used by JSN UniForm in both the front-end and back-end. It means that you can translate language
files and apply them yourself.
To use this function, you go to the Languages page of JSN UniForm -> click

to edit the language files.

Then, you can edit all the strings in the language files here. Here, you also can search for keywords to filter the translation.

To finish, you click Save and Close to apply your changes.

Please note that you can edit the language that you are installing on your site only.

Data

In this section, you can manage data in your website.
Sample Data Installation

Sample Data Installation is the perfect choice for users who are new to JSN UniForm. By installing sample data, you will have
predefined forms, so you can start using the product right away. Just follow simple on-screen instructions to install the sample
data.
Data Backup / Restore

The Data Backup / Restore function was built to keep your data safe. This is especially useful, when you are migrating a
website or upgrading to a new version of Joomla!. Keep in mind that this backup / restore feature covers only JSN UniForm
data, and not the entire website data.

Create a Basic Form
This section introduces the user to how to create a basic form with four simple steps. Like the screenshot.

Basic form

Let’s start!

Step 1: General settings
In the Components menu → click on JSN UniForm → Form.

Go to form

Next, click on the New button, here you can see seven options. We will start with Blank Form.

Type of forms

Next, go to General input the form’s title, select a Captcha Integration is ReCaptcha or Securimage.

General tab

In the Design tab, Form Type by default is Single Page and Form Layout by default is Vertical, you can change them as
needed.

Form design tab

Step 2: Add Field
Click on the Add Field button to select a field. There are have twenty-two fields for you. You can filter or search field name
to select.

Add field

After that, update properties for the field, there are Title, Size, Required or Hide. On the Values tab, you can settings for
separate features of each field.
On the image “Add field” above, you can see the checkbox to require the customer allow your website handle data. This is a
way to compose a GDPR compliant form for your Joomla! Site.
Edit the checkbox field, go to Values tab to edit checkbox items.
Delete all the items, and insert an acceptance demand note in the HTML code. In this case, it is: Allow JoomlaShine to
handle data in accordance with the privacy policy.
Click on Done button and Save your form.

Checkboxes field to compose a GDPR

Step 3: Preview the Form
After you have made changes to your form (if required) click the Preview button in the toolbar like the screenshot.

Preview form

Step 4: Show the Form
After your form is ready, it’s time to display it in the visitor area.
We have three ways to show the form on the frontend:
1. Via Menu Item
2. In Module Position
3. Inside Article

Three ways to show a form

1. Via Menu Item
Click on Via Menu Item to select a menu. After that, a new menu item will be created.
Input the Menu Title → click Save & Close → go to the frontend to check the form.

Show a form via the menu item

2. In Module Position
In Save & Show item in the toolbar → select In Module Position optional.
Module type is JSN UniForm → you need to input Module Title.
Add contents to the Top Content and Bottom Content.

Select the module position → click on the Save & Close button and check on your frontend.

Show a form via module position

3. Inside Article
Clicked on the Inside Article, you can see Plugin Syntax Details window.
Here show a line of text, you need to copy this line and paste to your article where you want to show form.

Show a form via inside article

Create a Payment Form
This section introduces the user to how to create a payment form with four simple steps to create a form like the screenshot.

Payment form

Step 1: General settings
In the Components menu → click on JSN UniForm → Form.

Go to form

Next, click on the New button, here you can see seven options. We will start with Blank Form.

Type of forms

In General tab input the form’s title, select a Captcha Integration is ReCaptcha or Securimage.
Select a Payment Integration, in this example we selected PayPal method. The Payment Integrations will be shown after
you installed payment plugins. Click back to Integrations (https://docs.google.com/document/d/1sevrf_1rFrc2flewqrNOrd4CTunMnrpaUTJpzxHoEg/edit#heading=h.ctrbfj34g1zs) to know how to install the payment
plugins.

General tab

In the Design tab, Form Type by default is Single Page and Form Layout by default is Vertical, you can change them as
needed.

Design tab

Step 2. Add Field
Click on the Add Field button to select a field. There are have twenty-two fields for you.
With the payment form, you should use some Conditional Fields (https://docs.google.com/document/d/1sevrf_1rFrc2flewqrNOrd4CTunMnrpaUTJpzxHoEg/edit#) are: Multiple Choice, Dropdown and Checkboxes.

A payment form

Total Money text: you can turn on/off to show this text by click on the edit icon on this row.
Click on the Edit icon, change the form’s title, add the class, instruction text, enable required, hidden and select the layout
for the form on the General tab.

General tab

On the Values tab, click on Edit button to change the item’s title.
Click on the Dollar icon to Add Price and Quantity for each option.

Edit and add the price for each option

Click the Lightning icon to hide or show fields when your customer select options.
In this example, the Product field we add five options, one of them is JSN UniForm and three fields to show the information of
JSN UniForm (License, Support, Extension are included). With four other options, we setting for hiding the form field for three

fields as the screenshot.

Hide form field

Also, you can see some setting options on Values tab of Conditional Fields.

Allow user's choice: this option allows the user to add user's choice.
Set the first item as the placeholder: When checked, the first item will be used as placeholder without contributing value
to form data.
Enable payment feature on this field: On each field, you need to Enable payment feature on field, click Yes to enable.
Show Price Label: Select Yes, if you want to enable price label of the product.

Step 3: Preview the Form
This step do the same as Step 3: Preview the Form of Create a Basic Form
(https://www.joomlashine.com/documentation/jsn-extensions/jsn-uniform/jsn-uniform-configuration-manual.html#create-abasic-form) section.

Step 4: Show the Form
This step do the same as Step 4: Show the Form step of Create a Basic Form
(https://www.joomlashine.com/documentation/jsn-extensions/jsn-uniform/jsn-uniform-configuration-manual.html#create-abasic-form) section.

Create a Submissions Menu Item
This feature allows you to create a menu item for user view and edit submissions from the frontend.

Menu Submissions presentation

To create Menu Submissions, we will get involved in 2 steps:

Step 1: Form General Settings
Once you finished the create a form step, in the General tab of JSN UniForm: Form Settings page to enable:
Allow Front-end Submission Editing if you want to be able to edit submission detail at the frontend.
Allow Front-end Submission Viewing if you want to be able to view submission detail at the frontend.
After enabling the options, you need to select permission for each option.

Allow Front-end Submission Viewing option

In this example, Allow Front-end Submission Viewing option is enabled and select permission is Public.

Step 2: Enable Save Submission
In the JSN UniForm: Form Settings page → click on Action tab to enable Save Submissions.

Enable Save Submissions

Step 3: Create a Menu Item
In a Menu Item Manager page in this example is Main Menu Manager page → click on the New button → on the Details tab,
enter the Menu Title → select Menu Item Type is JSN UniForm Submissions and select an object on the Access option.

Menu Item creation

Next, go to Display Options tab to select a Form for this menu, select Form Fields for display and enable some options allows
you to Show Data Filter, Date Filter, Field Selector, Submission Details, Submission Data and Submission Data for Owner.

Menu Item display options

Note:
Submission Data for Owner: Set Yes if you want the submissions will be visible to its owner only.
Don't forget to save any changes.

Tips & Tricks
Field Custom Class
You can assign custom class suffix for any form field and create the custom style for that class directly in JSN UniForm.
Click on the Edit button on each field, in the tab General, you can add your class to the Class input box:

Add custom class

In the tab CSS of Form Style dialog, you can freely define styles for this custom class.

Custom CSS for field

Quick translations
Different versions of Joomla have used slightly different ways to read language files (namely a custom parser and the native
PHP INI parser, the latter of which was buggy in PHP version and older), leading to different rules for what exactly is allowed in
keys and values.
To take quick translations, you need to go to JSN Uniform → Configuration → Language → Edit the current language → Edit the
language you want to change.

Edit language

Next, select a file (ini) and search the keyword you want to translate or change to other words.

Translation

Redirect based on selected value
If you want to have a dropdown field with many values which you click on them the display will be redirect based on dropdown
value. With JSN you can completely do it in just three steps.
Step 1: Select Dropdown field, edit this field and then put a unique/random CSS class to the General tab of the field. For
example, I added redirect_based_on_value class.

Add class

Step 2: Edit your value, go to Values tab to change your values which show on the dropdown.

Create values

Step 3: Go to Script tab, find On form display and then paste this code:

"$html .= "<script>jQuery('.jsn-uniform').on('change', '.redirect_based_on_value select', function(){
var selected = jQuery(this).val();
if (selected == 'Honda') {window.location = 'http://www.honda.com/'}
else if (selected == 'Yamaha') {window.open('http://www.yamaha.com/')}
else if (selected == 'Harley-Davidson') {window.location = 'http://www.harley-davidson.com/'}
else if (selected == 'Kawasaki') {window.location = 'https://www.kawasaki.com/'}
})</script>";

In this code, we have 2 types are redirect to targets: open a new page (Honda, Harley, Kawasaki) and open a new tab
(Yamaha).
Finally, click on the Save button and check the visitor area.

Validate the password
To validate the password before submitting form the first of all, you need to create a new Password Field.

Create a Form

Next, find the password field's ID.

Password field's ID

Go to Script tab, find On form process and then paste this code:

//ID of password field
$field_id = 25; //this ID just for this example
//List of the correct password
$accepted = array('bravebits','joomlashine','woorocket','sellersmith','golden','river');
if (!in_array($post['password'][$field_id][0], $accepted))

{
// Notice wrong password
echo '<input type="hidden" name="error" value=\'{"'.$field_id.'":"Wrong password"}\'/>';
exit();
}
In this code, with the passwords isn't in the $accepted = array('bravebits','joomlashine','woorocket','sellersmith','golden','river');
line, the display will shows Wrong Password notice.
Click on the Save button to finish and go to the visitor area to check.

Visitor area

Detect bad words
To detect bad words, you need to create a simple form with single line text, paragraph text fields.

Create a new form

After that, prepare a list of the bad words to add to this code:

$bad_words = array('zoombie','crack','macos',‘bug’); // List of the bad words
foreach ($post AS $field_id => $field)
{
foreach ($bad_words AS $bad_word)
{
if (strpos(strtolower($field), $bad_word))
{
//Found bad word
echo '<input type="hidden" name="error" value=\'{"'.$field_id.'":"This contain a bad word"}\'/>';
exit();
}
}
}
Go to Script tab, find On form process and then paste this code there, Save and check the result.

Typing the bad word

Stop sending duplicate information
In this example, we will customize for JSN Uniform to stop sending the duplicate email.
The first, create a simple form with email field and paragraph field like the image below:

Create a new form

Show this form to the visitor area and then you need to find the email field's ID.

Get the ID

Next, go to Script tab, find On form process and then paste this code:

$fieldId = 33;
$db = JFactory::getDbo();
$query = $db->getQuery(true);
$query->select('COUNT(*)');
$query->from($db->quoteName('#__jsn_uniform_submission_data'));
$query->where($db->quoteName('submission_data_value') . ' = '. $db->quote($post[$fieldId]));
$db->setQuery($query);
// Load the results as a list of stdClass objects (see later for more options on retrieving data).
$count = $db->loadResult();
if ($count > 0)
{
echo '<input type="hidden" name="error" value=\'{"'.$fieldId.'":"This email address is used."}\' />';
exit();
}
Finally, click on the Save and go to visitor area to check with an old email and a new email.

Visitor area

Create a fixed fee
Your forms are using any Payment method and you want to have a fixed fee. In this case, we will create a new dropdown field,
set price for the first item and hide this field by CSS.

Add a class

Next, you need to go Form Style → CSS and add this code there:

.please_hide_me{
display: none !important;
}

Add the CSS code

Finally, click on the Save and go to visitor area to check the result, it will show the same the image below.

Visitor area

Automatically enter the title
Create new form contain a field to save page title, for example like the image below:

Create a new form

Next, preview this form, right click on the field you want to using then choose Inspect Element to know the ID of this field.

Get the ID

After that, go to Scripts → On form display to add this code:

$article =& JTable::getInstance("content");
$article->load(JRequest::getInt("id"));
$title = $article->get("title");
$find = 'id="38" name="38" type="text" value=""'; // this example the field's ID is 38
$replace = 'id="38" name="38" type="text" value="'.$title.'" ';
$html = str_replace($find, $replace, $html);
Click on the Save button and go to visitor area to check.

This website uses cookies to ensure you get the best
experience on our website.

More information
(https://www.joomlashine.com/
joomlashine/privacypolicy.html)
Visitor area
Got It!

